
Digital Marketing Processes Sample 

Real Estate Marketing – Sample Structure 

Created a marketing system for real state agents that focuses on getting more prospects and leads that 

can be converted into a site visit and turn into sales afterwards. 

First, we need to know the main objective of the business: 

• Leads  

• Sales 

How did we do it? 

• Strategize 

• Creatives & Production 

• Placement 

• Review 

We make sure that we can deliver the following: 

• Story 

• Message 

• Purpose 

• Plan 

As we study the market locally, we make sure that we can determine the right audience with studying 

their current leads or buyers that they have. We translate that data to be applicable into digital 

marketing 

We have researched the following to be able to use on our digital marketing channels 

• Persona 

• Demographics 

• Location 

• Job titles 

• Interests 

• Keywords being used to search for Real Estate 

 

 

 

 

 

 



Strategy 

We will base our strategy on their main goal as a business who wants to improve their marketing 

strategies 

“How are we going to create more sales for them?” 

Compete into the current market space and create an uncontested marketspace. 

Two ways of delivering the brand in the market and create leads 

• Attract Existing Demand 

• Create Demand 

Deliver the brand without being too salesy or pushy 

• Videos that explains the advantage of getting a piece of real estate for residential purposes 

• Videos that explain the advantage of investing on real estate 

• Videos offering a FREE Consultation or Phone Consultation together with the topic above 

• Website Articles that discusses both topics above 

• Social Media Content that discusses the topics above 

 

We will follow a strong method that is being used but not being utilized on its maximum potential in 

every way on these contents. We will have a content that will focus on creating: 

• Attention 

• Interest 

• Desire 

• Action 

 

All the content above will have a landing page that focuses on generating leads and we will create a 

specific funnel for real estate to make sure that we are able to filter out highly qualified leads. 

• Basic sign up form to receive PDF File about “How you can win investing in real estate 101” or 

“The advantage of investing in real estate in (Insert Country)” for example. The PDF File has 

another call-to-action attached on the email or the PDF file itself. “FREE CONSULTATION – Call 

(Phone Number) or email us at (Email Address) 

• Once they sign up we will have their data base eligible for email marketing; email marketing is 

not going to be a spammy type like what most people do, we provide one-three emails in a 

week with a non-high traffic time for emailing it. It will be focused on just providing valuable 

contents such as “Why you should invest in real estate?”  

 

(Remember, when they are reading that PDF File they are already inquiring about your business)  

This lead nourishment process is what we call “Advanced Value Delivering”) 

 

 

 



 

Lead Nurturing and Harvesting  

In this phase, we will be nurturing our leads through the following methods 

• Email Marketing (Current Database) 

• Retargeted Ads (Custom Audience) PPE  

• Messenger Marketing (Active Subscribers) 

 

We will be harvesting all nurtured leads to proceed on the next step which can be 

• Phone Call Consultation 

• Site Visit Consultation 

This will move into a “Closing phase” which will be handled by the sales team. 

Creatives & Production 

After discussing strategy, we will be moving on how we can produce all of the creative materials and 

content that we need to use. 

We will produce the following and it always start with an article 

Article → Image → Videos  

This is the process that we always follow to make sure that we get the most out of one written content. 

We will start with an article that provides excellent value for our audiences to entice them to invest with 

real estate. From an article, we will be creating a graphical image, or a photo based by the written article 

with a good ad copy, from an image we will transform that image into a better one which is a video that 

we can use for ad.  

All of the creatives & content being created are going to have their own strategy which will mostly focus 

on the following: 

• Brand Strategy 

• Content Strategy 

• Sales Copywriting 

• Ad Copywriting 

• Creative Copywriting 

• Graphic Designing 

• Illustration 

• Article Writing 

• Video Production/ Video Content  

 

 



Placement 

After strategizing and planning on how we can produce the creative materials and content, we will 

discuss on what placements we should use to make the most out of our strategy. 

Our principle is delivering businesses/brands across every effective platform, we should have digital 

omnipresence with the business/brand being marketed. 

We discuss digital marketing channels we can use for real estate 

• Facebook 

• Instagram 

• Google  

• Email Platforms 

Specific Placements 

• Facebook (Organic & Paid) Facebook & Instagram Feed, Audience Network, In-Stream, Stories. 

• Google Search & Video Ads 

• Gmail & Google Partnered Websites 

The process involves a full data-driven method to be able to get the most out of all the campaign plan 

for the creative materials and content: 

• Facebook Pixel Integration 

• Google Analytics 

• Mailchimp or Wix 

• Google Trends 

• Audience Insight 

Facebook  

▪ Advertiser bid (either a manual or automatic bid 

▪ Estimated action rates (likelihood of driving a desired outcome)  

▪ User Value (website performance, ad quality, relevance of your ad to your audience)  

 Advertiser Bid x Estimated Action Rates + User Value = Total Value 

We will be doing multiple ad split testing for our Facebook ads that focuses on all possible conversion 

for our initial phase of getting data 

• Engagement 

• Traffic (Landing Page Views) 

• Conversion (After getting 1-5 sign ups using traffic campaign) 

• Three-Tier Micro Targeting (Using Audience Insight) 

o Interests (Pages that they liked) 

o Job Titles 

o Interests (Narrowing Down) 

 



Multiple Split Testing for: 

• Demographics 

• Location Targeting 

• Ad Creative 

We will maximize the potential for retargeting for: 

• Custom Audiences 

• Lookalike Audiences 

• PPE – Customer Audience for 95% Video Views 

End Path → Lead Generation Landing Page (For PDF Sign Up Download or For Consultation Requests) 

Google Ads 

• Keyword Research 

• Keyword Competitive Research 

• Conversion Optimization (Sign Up) 

Manual CPC for detailed monitoring for bidding 

Multiple Search Ad Testing 

• Search Ad Copy 

• Keyword Bidding Revisions 

• Strengthening Keywords & Eliminating Low Potential Keywords 

Data-Driven Data Analyzation using Google Analytics 

• Conversion Video Ads for Retargeting Click Traffic 

Creating Social Proof on Social Media Platforms 

• Follower/Liker Database 

• Provide Continuous Content  

• Interactive Page  

• Responsive Page 

• Integrate Platforms & Channels 

 

 

 

 

 

 

 



 

 

 

Review 

This is the process of monitoring our data thoroughly to see the winning ads and ads that needs to be 

eliminated or strengthened. With this process we can determine our current situation on how much are 

we able to improve using our campaign and also use the data to strategize better for our next campaign. 

 

• Facebook Ads Analytical Tool 

o Ad Split Testing 

o Custom Audience 

o Lookalike Audience 

o Multiple Micro Split Testing 

▪ Age Range 

▪ Relationship Status 

▪ Gender 

▪ Interests 

▪ Location 

• Ad Creative 

• Ad Copywriting 

• Google Analytics 

o Website Traffic Behavior 

▪ Session Duration 

▪ Bounce Rate 

o Website CTA Effectiveness 

• Manual Data Analyzing 

• ROAS & ROI 

• Data Analyzation 

• Data Translation 

Then after reading through the data and translating it into words on how we can understand it better; 

we will be able to do a new strategy to produce a better result on the next campaign. 

 

Results Produced for Our Real Estate Client (Broad Match & Projection) 20% Consultation, 10% Closing 

Month Leads Consultation Closed 

1st 50-100 10-20 1-2 

2nd 100-150 20-30 2-3 

3rd 150-200 20-40 2-4 

 



We’ve used the same structure of strategy for different types of businesses which delivers improvement 

as well that has a good ROI from the digital marketing investment they have. 

Business such as: 

• Franchising  

• Insurance 

• B2B Marketing 

• E-Commerce (With more detailed structures and optimization features) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Digital Marketing Structure 

Follow A.I.D.A Process on all aspects 

• Website 

• Ads 

• Copywriting 

• Downloadable PDF for Lead Generation 

• Creative Materials  

Digital Marketing Channels 

• Social Media Marketing 

• Search Engine Marketing 

• SEO (not my forte) 

• Website Lead Generation – Landing Page 

• Others; If necessary 

Process 

• Strategize 

• Creatives & Production 

• Placement 

• Review 

Social Media Management 

 Social Media Channels 

• Facebook  

• Instagram 

Process 

• Develop content that brings value to the audiences on the marketing channels (being a trusted 

source of info related to your business brings more value to your audiences and your brand) 

• Get a good number of likers/followers on your channels (This is to get what we call “Social 

Proofing or Brand Trust” which psychologically works for your audiences to trust your 

business/brand more. 

• Integrate all social media channels into your website.  

• Strategize your campaign calendar for both organic (Content – Not sales content) and Paid (Ads 

for lead gen etc.)  

Facebook/Instagram Ads Process 

 Tracking & Audience Research 

• Facebook Pixel 

• Custom Conversion (Lead Gen – or E-Commerce Terms E.G Add to Cart Etc.) 



• Audience Insight (Demographics, Age, Page Likes, Interests) 

Campaign Materials 

• Multiple Ad Copywriting (Persuasive Copywriting, Creative Copywriting) 

• Multiple Ad Creative 

• Multiple Targeting Audience Data 

Split Testing Process Example (Engagement, Landing Page Views, Conversion Etc.) 

1 Campaign = 2 Ad Sets = 2 Ads 

Campaign = Lead Generation for Food Kiosk Franchise  

Use Audience Insight and search for keywords related to the business 

Ad Set #1 (Three-Tier Targeting) 

Interests: Business, Business Insider, Forbes  

Narrow Audience: Facebook Page Admins, Business Page Admins, CEO, Managing Director, Chief 

Executive (Most businessmen are admins of their own business pages) 

Last Tier Narrow Audience: Franchising, Food Kiosks, Investment, Franchise Food Kiosks, Franchised 

Food Cart 

Conclusion – Ads will be delivered to the audience who are interested in business, who are engaging 

with business insider and Forbes; THAT ARE Facebook Page Admins, Business Page Admins, CEO, 

Managing Director and Chief Executives THAT ARE INTERESTED WITH – Franchising, Food Kiosks, 

Investment, Franchise Food Kiosks, Franchise Food Cart. 

(AGE TARGETING, GENDER, AND CIVIL STATUS SHOULD BE BASED ON AUDIENCE INSIGHT) 

Test for 1-2 weeks = Review Data → Re-strategize 

Ad Set #2 (Broad Targeting) – GOOD FOR INITIAL PHASE DATA TESTING 

Interests: Franchising, Business, Investment 

Age: 21-64 

Gender: Both 

Relationship Status: ALL 

Conclusion: Target a broader number of audiences that has an interest with franchising, business, 

investment.  Broad targeting of age, gender, and relationship status. 

Run Ads 1-2 Weeks = Review Data → Re-Strategize 

• Create Custom Audience (Based on ad data – Location, Gender, Age Range, Relationship 

Status, Interests) 

• If ad creative is a video – Create PPE – 50%  



• Re-target customer audience with a more aggressive ad 

Ad #1 

• Aggressive Sales Copywriting 

• Picture Ads 

• Promo Headline (Example: 50% OFF TODAY ONLY) 

Ad #2 

• Educational Copywriting (Talking about your product/service’s benefit to the audiences) 

• Short Video Ad 

• Action Headline (Example: Sign up now to get a FREE Consultation) 

Landing Page →  Website Lead Generation Optimized 

(PLACEMENT DEPENDS ON THE AD CREATIVE) 

Initial Ad can be focused on: 

• Reach 

• Engagement 

• Video Views 

• Traffic (Recommended for lead generation) 

First 1-2 weeks testing with CONVERSION – Create new campaign → Goal: Conversion (Sign Up, 

Purchase, Add to Cart Etc.) 

Google Ads 

• Search Ads 

• Display Ads 

• Video Ads (YouTube Ads) 

Tracking & Keyword Research 

• Google Analytics 

• Google Ads Conversion Tracking 

• Google Ads Analytics 

Campaign Materials 

• Search Ads 

o Ad Copywriting 

• Display Ads 

o Graphical Image (Dimension sizes should be flexible per placement type) 

o Ad Copywriting 

• Video Ads 

o Video Materials  

o Ad Copywriting 



o YouTube channels and YouTube Videos relevant to the brand/business being promoted 

Keyword Analysis 

• Keyword Research 

• Competitive Keyword Research 

• Keyword Bidding Analysis 

• Keyword Bidding Strategy 

Procedure: 

• Split Test Multiple Ad Copy and Ad Creative 

• Test and Monitor Keyword Conversion 

• Review Data: Keyword Conversion, Keyword Traffic, Device Behavior, Location, Demographics. 

• Re-Strategize Based on Campaign Data 

• Eliminate not converting keywords and scale highly converting keywords for your 

business/brand 

LANDING PAGE →  WEBSITE LEAD GENERATION OPTIMIZED 

 

WEBSITE FUNNEL STRATEGY FOR CONVERSION OPTIMIZATION 

GOAL: 

Determine the goal of the brand or business that you are promoting.  

Example: Sign Up Form, Download File, Purchase Item Etc. 

Follow A.I.D.A Process with the landing page content 

• ATTENTION 

• INTEREST 

• DESIRE 

• ACTION 

How are you able to add all these elements on your landing page? 

Make sure you have all of these: 

• What is it that you offer? 

• How will it make my life better? 

• What do I need to do to buy? 

 

 



 

How are you going to do it? 

• Make the headline/tagline of your homepage very direct (offer).  

• Use pictures of people happily using your products or describe the #1 benefit of using 
your product in the headline and testimonials (better life).  

• Have an obvious buy button prominently on the homepage and in the header or menu of 
the website (buy). 

“DELIVER VALUE PROPOSITION ON WHAT THEY ARE EXACTLY LOOKING FOR WHEN THEY GO TO 
YOUR LANDING PAGE” 

Landing Page Split-Testing Procedure 

1. Create two landing pages  
a. Different Content 
b. Different CTA  
c. Different Creative Materials 

2. Have a sign-up landing page for lead generation (Required: Data Gathering)  
3. Make sure that both landing pages are split-tested on your Facebook Ads and 

Google Ads. 
4. Create custom Google Analytics and Facebook Pixel for the two landing pages. 

Split-Test generally. 
5. Review data on your analytical tools – (Website Behavior, Conversion Rate, CTR-

Clicks, Session Duration, Bounce Rate) 
6. Re-strategize by doing continuous revisions by collaborating with the web 

developer and UI/UX Designer on how we can make a more conversion-
optimized landing page 

7. Scale high performing ads on the high converting landing page 
8. Repeat process in every campaign – Continuous revisions and data analyzing = 

continuous improvement. 

Gather Audience Database and Utilize 

• Sign-Up Data Base 

• Use Data to Create Custom Audience on Pixel (If possible, met requirements) 

• Maximize the opportunity for Email Marketing 

 

 

 

 

 

 



 

Email Marketing 

Tools 

• Mailchimp (Preferred) 

• Wix Email Feature 

• Lit Mus 

• Reach Mail 

Procedure 

• Use Database – Sign-Ups on your landing page 

• Create an email campaign strategy  

• Email Sales Copywriting, Creative Copywriting, Educational Copywriting 

• Determine best time for sending out emails, and conversion rate for opening emails & email 

clicks 

Nurture & Harvest Method 

• Send out emails that talks about the advantages of the products/services that your 

brand/business offers (Don’t focus on sending out sales emails) 

• Each email has a LIGHT CTA, so they can take an action if they want to move forward with the 

business 

• Create segmentation with your first email campaign from those people who opened your emails 

or clicked on them – Create a more aggressive approach on making them want to move forward 

• Continuously provide educational content for those prospects that are not YET moving forward 

with your business 

• Create a more aggressive ad or offer a promotion for those people who are showing interest 

already with your email content 

• Nurture your database, harvest the interested ones. 

 

 

End Conversion- Purchase, Sign Up, Call, Consultation Sign Up, Booking or Appointment Etc. 

 

 

 

Zack Briones 

Digital Marketing Strategist 

Box Digital PH 


